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Aim  
To find the relationship between computer performance and the clock speed of a Computer Processing 

Unit (CPU). 

Background Information 

Introduction 
Computers have become significantly more 

prevalent in society. Many individuals and 

companies use computers for various different 

tasks, including video production, rendering, 

gaming and general work. Performance is often 

a big issue with computers, as more 

performance can dramatically decrease the 

time it takes to do many of these tasks. This 

experiment will analyse how a change in the 

clock speed of a CPU affects the performance of 

a computer, using 6 tests. The results from these tests will reveal how much of a factor clock speed of 

the CPU is in computer performance in various tasks and how it scales. All other parts of the computer 

will be kept the same to make the test fair. This will allow analysis into whether spending money on 

CPUs or overclocking as a computer user is worth it for the performance gain. 

What is a CPU? What is clock speed? 
A CPU is a microprocessor that carries out 

instructions, and the speed of it is the 

independent variable for this experiment. Think 

of it as the brain of the computer. It receives an 

input from the senses, and outputs it to 

muscles or other parts of the body to carry out 

actions. In this example, the senses are the 

mouse, keyboard and other programs while the 

output is the monitor and program responses. 

CPUs have a clock signal that times their 

sequential operations. The frequency of the 

1) Computer used for this experiment 

2) CPU which is used in this experiment - an i5-4670k 
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clock determines the rate at which CPUs carry out instructions. The clock speed at which a CPU runs is 

measured in hertz (Hz). As modern computers run very quickly, they are measured in gigahertz (GHz). 

For example, a CPU at 2 GHz has 2,000,000,000 cycles a second, while one at 4 GHz has 4,000,000,000 

cycles a second.1  

According to BBC Bitesize, there are four main factors that affect CPU performance.2 They are cores, 

clock speed, cache size and the processor type. Clock speed has been explained in the above 

subheading. While the other three will not be changed in this experiment, it is nevertheless still 

important to understand their role in a CPU. Cores are explained below, while the others are in the 

appendix. 

In a CPU, there can be one or more processing units. 

Each of these processing units are called a core, and 

most CPUs are dual or quad core today. Having a 

processor with two cores is like having two processors 

inside one processor. Theoretically it doubles, triples or 

even quadruples performance. To give an example, it is 

like having two construction workers on one job. The 

two workers can theoretically do twice the amount of work than one worker could. Though, they have 

to talk to each other about what tasks to do and this takes time, so it is not completely efficient. The 

more workers or cores that are added, the more communication is needed. The CPU in this experiment 

has four cores, and one of the tests will examine single core performance. 

Do two processors with the same GHz have the same performance? 
Luke Lafreniere from LinusTechTips did research on how all MHz are not equal, and 4GHz in one 

processor with the same amount of cores does not always have the same performance as a different 

4GHz processor.3 This is because different processors have different instruction per clock (IPC) values. 

Newer processors have a better IPC, allowing more to be done every clock than an older CPU, which 

might have the same clock speed, but with a worse IPC value. Luke showed this by getting a 5690X 

(brand new top of the line Intel CPU) and comparing it to a Q6600 (seven year old Intel CPU). He made 

all the settings the same on both CPUs by restricting the clock speed and cores to be the same, but the 

                                                           
1 BBC Bitesize, ‘GCSC Computer Science - CPU and Memory’ - pg2 
2 Ibid pg2 
3 L Lafreniere, ‘Are All MHz Created Equal? – Intel 5960X vs Q6600 Comparison’ 

3) Diagram of Cores and Channels in a CPU - BBC Bitesize 
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5960X had 70% better performance in Cinebench R15 (a rendering benchmark). This is due to the fact 

that the 5960X has a better IPC value. Even if the same CPU model is used, the performance can be 

different. The only way to make the experiment completely fair is to use the exact same CPU. This is 

what this experiment does, as the same model CPU, an Intel i5 4670k is used throughout. 

How can CPU clock speed be changed? 
In most computers, the user cannot change the clock speed. Though, for ‘unlocked parts’, the user can 

change the clock speed, as well as many other settings of the CPU to any desired number. The CPU and 

motherboard used in this experiment are unlocked, allowing for the clock speed to be changed. The 

process of changing the clock speed of a processor is called either overclocking or underclocking, 

depending on whether the clock speed is raised or lowered respectively.4 Overclocking increases 

performance, but causes the processor to run hotter and use more power. On the other hand, 

underclocking reduces performance but causes the processor to run cooler and use less power. To 

change the clock speed, the user opens the basic input/output system (BIOS) of the computer and 

adjusts the setting called CPU Multiplier (number chosen by the user), which when multiplied by the 

CPU Base Clock (only a few to choose from, set by the manufacturer), equals the clock speed. For 

example, if the multiplier was set on 20, and the base clock on 100MHz, the clock speed would be 2GHz.  

How is CPU performance measured? 
Now that it has been explained how a CPU works, how is the performance measured in a CPU? There is 

no theoretical calculation to do so. CPUs are made for different purposes and uses, so they must be 

tested for their intended use. Some CPUs made for laptops are focused around consuming as little 

power as possible while CPUs in workstations and servers often contain many cores to complete many 

jobs at once. According to Chris Hoffman from Howtogeek.com, “you’ll probably want to look up actual 

benchmarks to see how the CPU stacks up compared to other CPUs in the real world. Actual benchmarks 

are the only reliable way of comparing computer and CPU performance.”5 There are many benchmarks 

on the market for different purposes, and are easy to look up or run.   

It is not possible to compare CPUs by simply comparing the clock speed, core count, processor type and 

cache. For example, a common question is asking if the Intel i7 4770k is better than the AMD 8350 or 

vice versa. These CPU’s are completely different on the inside and are made by different manufacturers. 

                                                           
4 Loyd Case. “Overclocking for Newbies” – PC World 
5 Chris Hoffman. “Why you can’t use CPU Clock Speed to Compare Computer Performance 
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The 8350 has better specifications on paper, with a higher clock speed and more cores, but is a few 

years older than the 4770k. There are also four benchmarks displayed below to compare performance. 

Table 1) Specifications of a 4770k and 8350 

CPU Name Clock Speed Cores Cache 

Intel i7 4770k6 3.5GHz 4 (8 Threads) 8MB 

AMD 83507 4.0GHz 8 (8 Threads) 8MB 

 

 

4) Blue is the 4770k, Red is the 8350 – Results from Anandtech8 

One might expect that the 8350 would be the better CPU but in most tasks, it isn’t. The 4770k is newer 

and is able to do more instructions per clock (IPC). In Cinebench R15, a rendering program, the 4770k 

shows much better performance. If a person wanted a computer for rendering, this would be the best 

choice out of the two. On the other hand, for 7-Zip compression the 4770k is slightly better while 

decompression is slightly better in the 8350. If a person wanted a CPU for 7-Zip or other 

compression/decompression programs, the cheapest one would be the best. This experiment will use 

benchmarks analysing the performance in all different types of general computer use to deduct the 

performance increase for various different uses. To measure performance in different tasks, 

benchmarks must be chosen for those tasks. Some common benchmarks include the two used above, as 

well as PCMark 8 for general performance, 3DMark 11 for gaming performance and handbrake for video 

encoding. These are all tasks that people use computers for every day. 

What is this experiment looking to find? 
This experiment is looking to find the relationship between different clock speeds. To do so, everything 

in the computer is kept the same except for the clock speed, which will be changed by the user. As 

                                                           
6 Intel, ‘ARK | Intel® Core™ i5-4670K Processor (6M Cache, up to 3.80 GHz)’ 
7AMD, ‘AMD Processors for Desktops’ 
8 Anandtech, ‘CPU Benchmarks’ 
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noted above, while cores, cache and the processor type will not be changed, it is important to know 

what they are. Using six different benchmarks listed in the paragraph above, the CPU will be tested at 

five different frequencies, graphed and analysed. 

Hypothesis 
CPU clock speed increases performance with a linear scale. Though, each task will scale at a different 

rate based on how dependant the task is on the CPU.  

Materials/Equipment 
 Computer (Note: Apart from the CPU, these other parts are constants, but are required to make 

the computer run and will affect the results). 

o CPU: Intel i5 4670k 3.4GHz (This is the independent variable) 

 Clock Speed: 2GHz, 2.5GHz, 3GHz, 3.5GHz, 4GHz 

 Cores: 4 

 Threads: 4 

 Cache: 6MB 

 Processor Type: CISC – Haswell. 

o CPU Cooler: Noctua NH-U9B SE2 

o Motherboard: Gigabyte Z87X-UD3H 

o RAM: Corsair Vengeance LP 16GB DDR3-1600 

o GPU: Sapphire AMD R9 290 Tri-X 

o SSD (Storage): Samsung EVO 840 250GB 

o PSU: Corsair RM750 

o Case: NZXT H230 

o OS: Windows 8.1 Pro x64 

 Benchmarks/Testing programs (These are the dependant variables, tested separately) 

o Cinebench R15 – RC83328DEMO (Rendering Performance) 

o Cinebench R15 – Single Thread (Single Thread Rendering Performance) 

o PCMark (Overall Computer Performance) 

o 3DMark (Gaming Performance) 

o 7-Zip 9.20 (Compressing and Decompressing) 

o Handbrake 0.10.2 (Video encoding) 

 Monitoring Programs 

o CPU-Z (Clock Speed and CPU info reporter) 

o HW Monitor (Temperature reporter) 

Variables 
 Independent Variable: 

o CPU Clock Speed 

 Dependant Variable 

o Performance number given in each of the 6 tests. 
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 Controlled Variables (Everything was kept the same apart from CPU Clock Speed) 

o Computer parts (Only thing that affects performance is CPU clock speed) 

o Computer programs open (close all non-necessary programs) 

o Using the same settings in each test 

Method 
1. Set up computer with the above equipment and install testing programs. 

2. Open BIOS by spamming F2 when the computer turns on and change the “CPU Multiplier” to 20, 

as well as turning off all power saving features. The feature to change is highlighted in the BIOS 

picture below. 

  

5) Picture of the BIOS. The CPU Multiplier is highlighted. 

3. Restart computer and open CPU-Z (pictured in the Diagram) and HWMonitor. Make sure that 

the CPU in CPU-Z is at the desired frequency and that the temperature of the CPU is below 90 in 

HWMonitor. This step makes sure that the CPU is at the right frequency and not overheating. 

 

6) Screenshot of CPU-Z. The number to look for is the Core Speed. Left is 4GHz and Right is 2GHz.  

4. Close all other programs. 

5. Run Cinebench R15 Tests (Picture Below) 

a. Open the program 
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b. Click File -> Advanced Benchmarks 

c. Run CPU test 3 times 

d. Run CPU Single Core test 3 times 

e. Record Results 

f. Close the program 

 

7) Screenshot of Cinebench R15 in the middle of the CPU test. 

6. Run 7-Zip Tests (Picture Below) 

a. Open 7-Zip 

b. Click Tools -> Benchmark 

c. Leave all settings on default and wait for one pass and record the last rating number. 

d. Click restart and repeat two more times 

e. Close the program 

 

8) 7-Zip Benchmark in the middle of a test. 

7. Run Handbrake Tests (Picture Below) 

a. Open Handbrake 
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b. Click source and open the selected video file 

c. Leave settings on normal and click start 

d. Once finished, Click Tools -> Activity Log -> Encode Log and copy the average FPS 

e. Record the result and repeat another two times 

f. Close the program 

 

9) Screenshot of the handbrake test once finished. 

8. Run 3DMark 11 Fire Strike Tests (Picture Below) 

a. Open 3DMark 11 

b. Run the “Fire Strike 1.1” test. 

c. Record the result number and copy the detailed result link 

d. Repeat another two times 

e. Close the program 

 

10) Screenshot of the start of the 3DMark Fire Strike test. 

9. Run PCMark 8 Creative 3.0 Conventional Tests (Picture Below) 

a. Open PCMark 8 
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b. Run the Creative Conventional Test 

c. Record the result number and copy the detailed result link 

d. Repeat another two times 

e. Close the program 

 

11) Screenshot of the start of the PCMark 8 test. 

10. Repeat steps 2-9 with the CPU Multiplier at 25, 30, 35 and 40. 

Risk Assessment 
This experiment has no risks in the method. There is no way to achieve an injury using a computer 

properly. Though, if a part in the computer needs to be added or replaced before the experiment, there 

is a small risk of electric shock. Below is a risk assessment table that should be followed in an accident. 

Risk Risk Reduction Accident Response 

Static Electric shock from 
touching computer parts 
when not in operation 

Don’t work on carpet. Unplug 
the pc before working on it. Use 
an antistatic wrist strap. 

Remove the thing that is shocking 
you and continue after a short 
break. If it is serious, seek medical 
attention or call 000. 

Table 2) Risk assessment 
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Results 
Cinebench R15 (CB)     

Clock Speed (GHz) Trial 1 Trial 2 Trial 3 Average 

1.99953 (2) 303 304 309 305.33 

2.49942 (2.5) 375 378 378 377 

2.99930 (3) 441 442 453 445.33 

4.39918 (3.5) 527 524 526 525.67 

3.99907 (4) 593 594 594 593.67 

Cinebench R15 Sing Thread (CB) 

Clock Speed (GHz) Trial 1 Trial 2 Trial 3 Average 

1.99953 (2) 79 80 81 80 

2.49942 (2.5) 100 98 99 99 

2.99930 (3) 113 117 119 116.33 

4.39918 (3.5) 138 138 137 137.67 

3.99907 (4) 154 154 154 154 

3DMark 11 Fire Strike 1.1                       

Clock Speed (GHz) Trial 1 Trial 2 Trial 3 Average 

1.99953 (2) 7433 7457 7444 7444.67 

2.49942 (2.5) 8095 8009 8116 8073.33 

2.99930 (3) 8420 8346 8399 8388.33 

4.39918 (3.5) 8896 8873 8635 8801.33 

3.99907 (4) 9077 9084 9098 9086.33 

PCMark 8 Creative 3.0 Con 

Clock Speed (GHz) Trial 1 Trial 2 Trial 3 Average 

1.99953 (2) 3138 3135 3157 3143.33 

2.49942 (2.5) 3518 3522 3521 3520.33 

2.99930 (3) 3840 3847 3837 3841.33 

4.39918 (3.5) 4152 4155 4129 4145.33 

3.99907 (4) 4389 4406 4418 4404.33 

7-Zip 32MB 4T (MIPS) 

Clock Speed (GHz) Trial 1 Trial 2 Trial 3 Average 

1.99953 (2) 9568 9439 9353 9453.33 

2.49942 (2.5) 11385 11522 11442 11449.67 

2.99930 (3) 13707 13611 13910 16742.67 

4.39918 (3.5) 15754 15853 15653 15753.33 

3.99907 (4) 18208 18350 18313 18290.33 

Handbrake 

Clock Speed (GHz) Trial 1 (Av. FPS) Trial 2 (Av. FPS) Trial 3 (Av. FPS) Average 

1.99953 (2) 137.6 137.2 140.9 138.57 

2.49942 (2.5) 168.3 166.3 168.9 167.84 

2.99930 (3) 196.5 192.3 195.0 194.60 

4.39918 (3.5) 232.3 231.3 229.8 231.13 

3.99907 (4) 256.0 256.2 254.5 255.56 
Table 3) Experiment Results. 
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Graphs  
Black line is a linear line of best fit. 

 

 

305.33

377

445.33

525.67

593.67

R² = 0.9994

300

350

400

450

500

550

600

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re

CPU Clock Speed (GHz)

Cinebench R15

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154

80

99

116.33

137.67

154
R² = 0.9988

80

90

100

110

120

130

140

150

160

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re

CPU Clock Speed (GHz)

Cinebench R15 Single Thread



Sebastian Hodge | CPU Clock Speed and Performance 

Page | 14  
 

 

 

7444.67

8073.33

8388.33

8801.33

9086.33
R² = 0.9793

7000

7500

8000

8500

9000

9500

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re

CPU Clock Speed (GHz)

3DMark 11 Fire Strike 1.1

3143.33

3520.33

3841.33

4145.33

4404.33
R² = 0.9953

3000

3200

3400

3600

3800

4000

4200

4400

4600

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re

CPU Clock Speed (GHz)

PCMark 8 Creative 3.0 Conventional



Sebastian Hodge | CPU Clock Speed and Performance 

Page | 15  
 

 

 

 

9453.33

11449.67

13742.67

15753.33

18290.33

9453.33

11449.67

13742.67

15753.33

18290.33

R² = 0.9984

9000

10000

11000

12000

13000

14000

15000

16000

17000

18000

19000

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re
 (

M
IP

S)

CPU Clock Speed (GHz)

7-Zip Benchmark 32MB

138.57

167.84

194.6

231.13

255.56
R² = 0.9971

130

150

170

190

210

230

250

270

2GHz 2.5GHz 3GHz 3.5GHz 4GHz

Sc
o

re
 (

A
ve

ra
ge

 F
P

S)

CPU Clock Speed (GHz)

Handbrake



Sebastian Hodge | CPU Clock Speed and Performance 

Page | 16  
 

Discussion 
With the experiment now complete, there has been a consistent trend throughout each of the six 

benchmarks. With an R squared value very close to one in every test and a clear linear line of best fit in 

each graph, it is obvious to see that when the clock speed is increased, the score that is achieved 

increases with a linear relationship.  

This section will analyse each benchmark separately in more detail.  

According to Maxon, the creator of Cinebench R15, Cinebench is a real-world cross platform based on 

Cinema 4D, which is a popular animation program. Cinema 4D has been used for movies like Iron Man 3, 

Spider-man 3, Life of Pi and Oblivion9, making Cinebench R15 a program that is very good for analysing 

real world performance. The results in both the single threaded and normal Cinebench CPU tests are 

very promising. Both tests showed very linear results, with an r squared value of 0.9994 and the points 

all lying on a straight line of best fit. For a 100% increase of clock speed between 2GHz and 4GHz, the 

performance in Cinebench R15 shows a 94.4% ([593.67/305.33 – 1] * 100) increase with all threads and 

a 92.5% ([154/80 - 1] * 100) increase in the single thread test. With a less than 10% theoretical 

performance loss, these results show how well CPU clock speed scales in performance for still image 

rendering, where the CPU is pretty much the only used component. People who do image rendering on 

an regular basis should look to buying high clock speed CPUs as it dramatically reduces the time it takes 

to render images. Professionals working on top of the line movies have access to much more powerful 

computers and render farms, but for people making desktop backgrounds or videos, investing in a high 

clock speed CPU will dramatically reduce the time it takes to make these images. 

The 3DMark 11 Fire Strike 1.1 test is very different to many of the other tests in this experiment. Unlike 

the other 5 benchmarks, the 3DMark series of benchmarks are made for graphics cards. Fire Strike is 

built to test DirectX 11 (an application programming interface or API) performance, which is mainly used 

for video games10. Due to this, most of the pressure is put on the graphics card and not the CPU, so 

while a linear increase is expected, it is not a CPU only task and will not scale like Cinebench R15 did. Fire 

Strike is made up of a few different tests packaged into one, with the two main categories being physics 

and graphics. To put it simply, the graphics tests uses the GPU, while the physics uses the CPU (kept the 

same in all these tests). The GPU has a lot bigger role in most video games today, so the 22% increase in 

                                                           
9 Maxon, ‘Maxon CINEBENCH Overview’ - http://www.maxon.net/en/products/cinebench/overview.html 
10 Futuremark, ‘3DMark cross platform benchmark for Windows, Android and iOS’ 
http://www.maxon.net/en/products/cinebench/overview.html 

 

http://www.maxon.net/en/products/cinebench/overview.html
http://www.maxon.net/en/products/cinebench/overview.html
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performance that was given with the 100% jump from two to four GHz shows how the CPU does not 

have a big role in games ([9086.33/7444.67 - 1] * 100). Using the detailed scores given by Fire Strike, it 

proves this. The graphics score for one of the 4GHz tests was 11119, while for one of the 2GHz tests, the 

graphics score was 11145. This shows that the CPU had no effect on graphics, and only the physics 

calculations. For the first test, they were 3445 for 2GHz and 7885 for 4GHz (these can be found by using 

the results table or the examples in the appendix). For people looking to play games, the CPU often 

comes secondary to the GPU, and these results show this. Though, each game has different needs for 

the CPU and GPU, so this test aims to give general results. For people looking to play games, they should 

focus on their GPU and not the CPU, as this part of the experiment showed that spending money to 

purchase a CPU with 4GHz only provided 20% more performance than a CPU at 2GHz. 

PCMark 8 Creative is a test made to emulate and quantify the performance in 12 different everyday 

tasks used by creative professionals. It tests tasks such as video editing, web browsing, music, video 

group chat, video watching and imaging editing, just to name a few. This benchmark is used by most 

major technology companies like Samsung, Microsoft, Dell and Intel, and was chosen because it is a task 

that could benefit from higher CPU clocks, unlike the Home test, which tests performance in tasks like 

word documents and internet browsing. Some of these tasks scale well with CPU performance and some 

do not, but this benchmark was made to test real world relevance for office computers. Again, the 

performance scaled linearly, and a doubling of the clock speed gave 40% ([4404.33/3143.33 - 1] * 100) 

better performance. Similar to the results above, for people doing CPU heavy tasks like photo or video 

editing, a better CPU shows its performance benefits. For things such as music, web browsing and group 

video chat, there was no performance increase whatsoever. For people in the creative or design 

industries, this CPU shows that a powerful CPU is beneficial, while most office workers browsing the 

internet and writing word documents are fine with a cheap or low power CPU, as that is more 

important. 

The 7-Zip and Handbrake tests are the last two tests done and show performance in programs that 

aren’t used often, but rely on the CPU quite a lot. 7-Zip is a compression and decompression program 

that is widely used. For a doubling in clock speed, performance increased by 93% ([18290.33/9453.33 - 

1] * 100). This is an application where clock speed scales really well, similar to rendering. Handbrake is a 

video encoding program. It did not scale as well as the other CPU heavy tasks, with a doubling in clock 

speed giving an 84% ([255.56/138.57 - 1] * 100) increase in performance. These results, as well as the 

results in the previous four benchmarks were expected and align very well with the theory. 
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As the results in all six benchmarks have been analyzed, cost and practicality must be weighed into it. 

Not everyone has the budget or the need to go out and spend thousands of dollars on a CPU that 

consumes a lot of power to achieve the most performance. Hardly anyone does it. The people that 

benefit from CPU’s with high clock speeds are professionals and enthusiasts looking for extra 

performance in CPU heavy tasks, which include things like video encoding, image rendering, encoding 

and physics. This experiment has proved that these tasks gain an incredible amount of performance 

from higher clock speeds, and the people who do these tasks normally know about this. For an average 

office worker, student or gamer, clock speed does not have a big effect. No one needs the latest CPU to 

type up a word document or go on Facebook, and users looking to do tasks like this should look at other 

things. People playing games should look go a good GPU while people looking to browse the web should 

look at cost and battery life. There are many sources that review the performance of many parts, and 

they should be looked at to make an informed decision about what CPU or computer to buy. For most 

people, spending an extra $200 on an i7 CPU is not worth it unless the user wants to use the computer 

for a high scaling CPU intensive task like Handbrake or Cinebench. 

The question of whether to overclock or not when buying a computer is related to this experiment. As 

noted in the background information section, overclocking is the process of raising the clock speed of a 

processor above its stock level to get more performance. Normally only done on desktop computers, it 

causes extra heat and power consumption. As this experiment details how CPU performance scales, it 

can now be established if overclocking is worth it for the end user.  

The 4690k is the new refresh of the 4670k, with basically the same processor. It retails for A$320 (at the 

time this was written)11 and has a stock speed of 3.5GHz. The locked version, the 4690, retails for A$295. 

The extra price in other parts required to overclock is about $75 minimum. Most people have been able 

to achieve an overclock to 4.5GHz. To do so costs an extra $100. Using the graph, a 4.5GHz CPU in 

Cinebench R15 would give a performance increase to 674 CB. This gives an extra 28% increase in 

performance over the stock CPU in Cinebench R15, but costs $550 instead of $450. Showing how 

performance scales in these programs can give insight into doing cost benefit calculations for these 

applications. Though, they are only useful for this generation of Intel CPU’s, the current generation. A 

cost benefit analysis into overclocking is just an example of what these results can be used for. 

                                                           
11 PCPartPicker - https://au.pcpartpicker.com – Used to find the current lowest price parts. 

https://au.pcpartpicker.com/
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Reliability is an important part of every scientific experiment. To make sure the data was reliable, the 

experiment was repeated three times. These results were then averaged to find the mean result, which 

is used in all the graphs and for all the analysis. The results were also checked with each other. If a result 

was completely different to the other two, something had been done wrong. Some programs could have 

been kept open while the test was running or the wrong settings had been used. All the results were 

very close to each other, with most results only a few numbers away from the average. 

Making sure the experiment can be repeated easily is very important to making it a valid experiment. 

The method is long on paper but most of the steps are very simple and cannot be mistaken for 

something else. The method was also written so that someone who barely uses computers can follow it. 

Instead of writing, ‘start the Cinebench R15 benchmark’, the process to start the benchmark would take 

a few steps, going through which buttons to press and to make sure that all the other programs are 

closed. Pictures of each part of the method was also added, and as most of the experiment was done on 

the computer, with only the set up being physical, adding screenshots was the easiest way to do this. 

This experiment was also quite accurate. The programs used to measure the result are some of the most 

well-known and best programs used to benchmark performance. The results given were the results 

used, and no mistake can be made reading the results off the computer screen as it is digital. This test 

was also valid. A lot of focus was on making the experiment a ‘fair test’. To do this, there was only one 

thing changed by the user, which was the CPU clock speed, and all the other conditions were kept the 

same. Some constant variables include the programs kept open and the other CPU settings. Even if 

something like an internet browser was left open or google drive was left on, the test results would be 

affected. 

A few problems were identified and fixed with the method. Firstly, 

the CPU was overheating at 4GHz.  This was due to the fact that the 

stock cooler was originally used to cool the CPU, which was not good 

enough for higher clock speeds. To fix this, an aftermarket Noctua 

NH-U9B SE2 was purchased. This can cool the CPU much better and 

allowed the CPU to reach 4GHz while staying at 60C. HWMonitor 

was also used to diagnose this problem, showing the heat that the 

CPU was given of to keep it stable. Secondly, to continue with the 

other programs being left open, all active programs were closed but 

tasks such as Google Drive were left open at first. Everything that was 
12) Noctua NH-U9B SE2 
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possible to close was closed. Though, this could never be perfect as Windows 8.1 requires some 

processes to be left open so the operating system (OS) can function. Due to research and planning, 

these were the only two problems that needed to be fixed. 

If this experiment was done again, a few things could have been improved. Firstly, more data points 

would have improved the experiment. The same could be said for the amount of benchmarks, and more 

benchmarks in more programs would highlight the effect of higher clock speeds with more uses. If there 

was more time to do the experiment, this would have been achievable. The biggest problem was with 

PCMark 8 and the fact that one run-through took an hour to do. With 15 repetitions, it took 15 hours of 

straight time to complete just that benchmark. The other benchmarks were more reasonable, taking 

between a minute and 15 minutes to complete. 

This experiment has been quite enjoyable. Nearly everyone today uses computers, but hardly any of 

them know how they work. Looking at the core component of the CPU, this has been very informative 

into learning how the CPU works and how users can change the performance that it gives. The 

experiment gave very concrete results and adds to both scientific knowledge and real world knowledge, 

useful for guiding people to buy the correct processor for their needs. This report did not go into 

specifics about what computers to buy, only giving a short example about overclocking, but the results 

can be applied to many computers on the market to help work out what CPU is better. 

Conclusion 
CPU clock speed scales with computer performance in a linear fashion no matter the task. For CPU 

heavy tasks, which were Cinebench R15, Handbrake and 7-Zip, performance scales at 85-95% efficiency, 

while in non CPU heavy tasks like 3DMark 11 and PCMark 8, performance scaled between 20-40%. 
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Appendix 

Definitions 
 CPU 

o The computer processing unit (CPU) is the brain of the computer that processes 

information. Explained in more detail on pg3. 

 CPU Cooler 

o An object that is made to cool the CPU and keep it under the maximum operating 

temperature. An example is the Noctua NH-U9B SE2. This is explained in more detail on 

pg18. 

 Motherboard 

o The part of the computer that connects all the different parts of the computer together. 

 GPU 

o The graphics processing unit (GPU) is similar to a CPU but has a lot slower clock speed 

and many more cores. It is made to render many images quickly, and is used for some 

types of video rendering or gaming. 

 Rendering 

o The process of generating an image from a 2D or 3D computer model. 

 Overclocking 

o The process of raising the CPU clock speed to increase performance in exchange for heat 

and battery life. 

 Underclocking 

o The opposite of overclocking. 

 Clock Speed 

o The speed of the internal clock of the processor. It determines the amount of 

calculations that the processor can do a second 

 Core 

o A processor inside a processor. Multi core processors have two or more cores inside one 

processor, which is like having two or more processors. Explained in more detail on pg4. 

 Thread 

o A thread is an “ordered sequence of instructions that tells the computer what to do.” 

Explained in more detail on pg4. 

https://en.wikipedia.org/wiki/Megahertz_myth
https://www.youtube.com/watch?v=wfoI-m-3vOk&index=4&list=PL8mG-RkN2uTzxKz-jbEIsZDIHfz_CBGGx
https://www.youtube.com/watch?v=wfoI-m-3vOk&index=4&list=PL8mG-RkN2uTzxKz-jbEIsZDIHfz_CBGGx
http://www.pcworld.com/article/198882/overclocking_for_newbies.html
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 Cache 

o Very fast memory that is inside the CPU. Explained in more detail on pg4. 

 Processor Type 

o There are two main types, complex instruction set computing (CISC) and reduced 

instruction set computing (RISC). This is explained in more detail on pg4. 

 CPU Fabrication 

o The process of creating the CPU. The fabrication number (or die size), which companies 

aim to get smaller, allows the size of the CPU parts to get smaller, and therefore fit more 

parts in a CPU. 

 CPU Architecture 

o CPU Architecture is how the CPU is designed. Designers are constantly working to 

improve the Architecture, which along with die size, increases performance in a CPU. 

 Instruction per Clock 

o The amount of work a processor can do every clock. This number changes for different 

applications and is not a set number. Explained in more detail on pg5. 

 Unlocked Processor 

o An unlocked processor can have values like the clock speed changed. For Intel CPU’s, the 

K ending specifies an unlocked processor. 

 Instruction Cycle 

o The cycle that the CPU repeats to process information. It does so until the CPU is shut 

down. Explained in more detail on pg5. 

 BIOS 

o The basic input/output system (BIOS) is the first program that a computer boots into. 

This program sets the settings for the computer parts and helps the operating system 

launch. 

 Operating System 

o The operating system is the environment that runs the programs that users want. Some 

examples of an operating systems include Windows, OSX, Android, iOS and Linux. 

 Benchmark 

o A program that has been designed to test performance. There are many different 

benchmarks on the market. 

 Cinebench R15 

o A benchmark by Maxon based on Cinema 4D. More detail on pg16. 

 7-Zip 

o A compression and decompression program. More detail on pg17. 

 Handbrake 

o A video encoding program. Used to turn MKV files in to MP4 files, etc. More detail on 

pg17. 

 3DMark 11 Fire Strike 

o A GPU test made to test gaming performance. It is explained in more detail on pg16. 

 PCMark 8 Creative 

o A test made to test real world office creative uses. It is explained in more detail on pg16. 
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Other Factors for CPU Performance 
Threads: Inside cores, there are threads of execution (thread). According to Jon Stokes, a thread is 

“merely an ordered sequence of instructions that tells the computer what to do.”12 Cores just process 

information, the threads are what feed the information to the CPU. Having two threads is called 

Hyperthreading, and while Hyperthreading is used in many processors, it is not used in this experiment. 

Knowing what a thread is will be needed to analyse some results though. 

Cache: CPU cache is a very small amount of memory that is faster and located inside the CPU, unlike 

RAM. It allows the CPU to hold information that the CPU is currently using and reuse it quickly.13 There 

are different levels of cache, with L1 being the closest to the core, followed by L2 and L3. Cache is 

usually very small, measured in MB and KB depending on the level. 

Processor type: Finally, different processors calculate information in different ways. There are two types 

of CPUs. They are complex instruction set computing (CISC) and reduced instruction set computing 

(RISC). CISC CPUs are used in desktops as well as laptops, and are made for complex instructions. On the 

other hand, RISC CPUs are used in portable devices like phones, and are cheaper to make. This is also 

known as the architecture type. The processor used for this experiment is a CISC CPU. Inside these 

subheadings, CPUs start to become more efficient at performing the same tasks with the same clock 

speed and cores. As time goes on, CPU manufacturers make the CPUs more efficient and reduce the 

fabrication process. This allows newer CPUs to be faster, while having the same clock speed and core 

count. This explanation of how a CPU works is just the surface, and they can be looked at into more 

detail. 

Now that the four main factors that affect CPU performance have been established, it is important to 

look at how the CPU carries out these instructions. This is called the instruction cycle. Bosky Agawal 

from Montana State University says there are four main steps that a CPU uses to process information.14 

Firstly, the CPU ‘fetches’ the instruction from the memory and puts it in the cache. Secondly, the CPU 

decodes the instruction. Thirdly, the CPU works out what operation it is. Finally, the CPU executes the 

instruction. This is all happening in each of the cores and fed by each of the threads. The last step is the 

only useful cycle, but the first three are required to start the execute stage. 

                                                           
12 Stokes, J. ‘Ask Ars: what's the relationship between CPU clock speed and performance?’ 
13 BBC Bitesize as above pg3 
14 Bosky Agarwal (2004). "Instruction Fetch Execute Cycle" (PDF). Retrieved 2012-10-14. 
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Intel 4th Generation CPU naming scheme 

 

 Brand 

o Intel’s brand name 

 Brand Modifier 

o i3, i5 or i7, quick performance identifier 

 Generation Indicator 

o 1,2,3,4 or 5. Tells the user what generation the processor is from. Basically the release 

date. 

 SKU Numeric Digits 

o Identifies the specific CPU. A higher number is better. 

 Product Line Suffix 

o Gives information about the processor. K is unlocked, R his high graphics, T is power 

optimized, and S is performance optimised. Can be blank. 

Detailed 3DMark 11 and PCMark 8 Results. 
3DMark 11 Fire Strike 1.1 Trial 1 Trial 2 Trial 3 

2GHz 7433 (5084051) 7457 (5158064) 7444 (5158143) 

2.5GHz 8095 (5084878) 8009 (5084950) 8116 (5166020) 

3GHz 8420 (5094378) 8346 (5094466) 8399 (5110461) 

3.5GHz 8896 (5135162) 8873 (5135203) 8635 (5135250) 

4GHz 9077 (5157208) 9084 (5157208) 9098 (5157439) 

PCMark 8 Creative 3.0 Con Trial 1 Trial 2 Trial 3 

2GHz 3138 (24443) 3135 (24735) 3157 (24738) 

2.5GHz 3518 (24448) 3522 (24451) 3521 (24740) 

3GHz 3840 (24495) 3847 (24501) 3837 (24536) 

3.5GHz 4152 (24621) 4155 (24623) 4129 (24626) 

4GHz 4389 (24694) 4406 (24701) 4418 (24703) 

 

3DMark 11 and PCMark 8 give detailed results on their website and show that the experiment was 

completed and is valid. For more detailed 3DMark and PCMark results, the code in brackets next to the 

result can be added to either http://www.3dmark.com/fs/(number) or 

http://www.3dmark.com/pcm8cr3/(number) respectively to find more detailed results. Below are some 

examples of the more detailed results. There are also charts to compare the performance of the 

computer to other people’s computers. 

 

 

http://www.3dmark.com/fs/(number)
http://www.3dmark.com/pcm8cr3/(number)
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2GHz – Test 1 – 3DMark11 

 

4GHz – Test 1 – 3DMark 11 

 

 


